S32K144 EVB

QUICK START GUIDE

REV4.3

APPLIES FOR: S32K144 EVB (SCH-29248 REV B)
Contents:

• Get to Know S32K144 EVB
• JumpStart Setup
• JumpStart based on the FreeMASTER tool
• Introduction to OpenSDA
• Creating a new S32DS project for S32K144
• S32DS Debug basics
• Create a P&E debug configuration
Get to know S32K144-EVB

- CAN Communication Bus
- LIN Communication Bus
- OpenSDA USB
- Reset Button
- OpenSDA MCU
- J2 Header
- J14 SWD connector
- J1 Header
- J6 Header
- J5 Header
- J4 Header
- J3 Header
- SBC UJA1169
- External Power Supply (5-12V)
- OpenSDA JTAG
- S32K144 MCU
- Touch electrodes
- RGB LED
- Potentiometer
- User Buttons
S32K144 EVB Features:

- Supports S32K144 100LQFP
- Small form factor size supports up to 6” x 4”
- Arduino™ UNO footprint-compatible with expansion “shield” support
- Integrated open-standard serial and debug adapter (OpenSDA) with support for several industry-standard debug interfaces
- Easy access to the MCU I/O header pins for prototyping
- On-chip connectivity for CAN, LIN, UART/SCI.
- SBC UJA1169 and LIN phy TJA1027
- Potentiometer for precise voltage and analog measurement
- RGB LED
- Two push-button switches (SW2 and SW3) and two touch electrodes
- Flexible power supply options
  - microUSB or
  - external 12V power supply
### Header/Pinout Mapping for S32K144

**Arduino compatible pins**

**NXP pins**

*0ohm resistor is not connected*
# Jumper Settings

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J104</td>
<td>1-2</td>
<td>Reset signal to OpenSDA, use to enter into OpenSDA Bootloader mode</td>
</tr>
<tr>
<td></td>
<td>2-3 (Default)</td>
<td>Reset signal direct to the MCU, use to reset S32K144.</td>
</tr>
<tr>
<td>J107</td>
<td>1-2</td>
<td>S32K144 powered by 12V power source.</td>
</tr>
<tr>
<td></td>
<td>2-3 (Default)</td>
<td>S32K144 powered by USB micro connector.</td>
</tr>
<tr>
<td>J109/J108</td>
<td>1-2 (Default)</td>
<td>Removes CAN termination resistor</td>
</tr>
</tbody>
</table>
## HMI mapping

<table>
<thead>
<tr>
<th>Component</th>
<th>S32K144</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red LED</td>
<td>PTD15 (FTM0 CH0)</td>
</tr>
<tr>
<td>Blue LED</td>
<td>PTD0 (FTM0 CH2)</td>
</tr>
<tr>
<td>Green LED</td>
<td>PTD16 (FTM0 CH1)</td>
</tr>
<tr>
<td>Potentiometer</td>
<td>PTC14 (ADC0_SE12)</td>
</tr>
<tr>
<td>SW2</td>
<td>PTC12</td>
</tr>
<tr>
<td>SW3</td>
<td>PTC13</td>
</tr>
<tr>
<td>OpenSDA UART TX</td>
<td>PTC7 (LPUART1_TX)</td>
</tr>
<tr>
<td>OpenSDA UART RX</td>
<td>PTC6 (LPUART1_RX)</td>
</tr>
<tr>
<td>CAN TX</td>
<td>PTE5 (CAN0_TX)</td>
</tr>
<tr>
<td>CAN RX</td>
<td>PTE4 (CAN0_RX)</td>
</tr>
<tr>
<td>LIN TX</td>
<td>PTD7 (LPUART2_TX)</td>
</tr>
<tr>
<td>LIN RX</td>
<td>PTD6 (LPUART2_RX)</td>
</tr>
<tr>
<td>SBC_SCK</td>
<td>PTB14 (LPSPI1_SCK)</td>
</tr>
<tr>
<td>SBC_MISO</td>
<td>PTB15 (LPSPI1_SIN)</td>
</tr>
<tr>
<td>SBC_MOSI</td>
<td>PTB16 (LPSPI1_SOUT)</td>
</tr>
<tr>
<td>SBC_CS</td>
<td>PTB17 (LPSPI1_PCS3)</td>
</tr>
</tbody>
</table>
S32K144 EVB
JUMPSTART
Step 1: Power up the Board – EVB Power Supplies

- The S32K144-EVB evaluation board powers from a USB or external 12V power supply. By default USB power is enabled with J107 (check slide 5)

- Connect the USB cable to a PC using supplied USB cable.

- Connect other end of USB cable (microUSB) to mini-B port on FRDM-KEA at J7

- Allow the PC to automatically configure the USB drivers if needed

- Debug is done using OpenSDA through J7
Step 1: Power up the Board – Is it powered on correctly?

- When powered through USB, LEDs D2 and D3 should light green
- Once the board is recognized, it should appear as a mass storage device in your PC with the name EVB-S32K144.
Step 1: Power up the Board – Is it powered on correctly?

- Board is preloaded with a software, in which the red, blue and green LEDs will toggle at different rates.
S32K144 EVB JUMPSTART BASED ON THE FREEMASTER TOOL
Install the FreeMASTER tool

- Download and install the FreeMASTER PC application [www.nxp.com/FreeMASTER](http://www.nxp.com/FreeMASTER).
- Open the FreeMASTER application on your PC. You should see Welcome page:
Power up the EVB board

- Powers the S32K144EVB evaluation board from a USB. By default, the USB power is enabled by J107 jumper (2-3 closed).
- Connect the USB cable to a PC and connect micro USB connector of the USB cable to micro-B port J7 on the S32K144EVB.
- Allow the PC to automatically configure the USB drivers if needed.
- When EVB is powered from USB, LEDs D2 and D3 should light green.
- The EVB board is preloaded with a software toggling the RGB LED colours periodically between RED-GREEN-BLUE.
Setup serial connection in the FreeMASTER tool

Setup communication port to „opensda“ and speed to 115200 b/s:

- Setup communication manually:
  „Project > Options > Comm“

  OR

- Setup communication automatically:
  „Tools > Connection Wizard“
The FreeMASTER JumpStart project will be automatically downloaded from [www.nxp.com](http://www.nxp.com).

Once the FreeMASTER application detects the web address stored as an TSA active content in the flash memory of the S32K144 MCU, the download of the FreeMASTER project from [www.nxp.com](http://www.nxp.com) will be initiated.

**Explore the Board**

The attached board contains a graphical content you may want to see first.

- (opens in 0 sec loading project, please wait...).
The FreeMASTER JumpStart project is loaded

Pins of the J2, J1 and J6 connectors are configured as outputs (except pins 10 and 12 on the J2 connector).

S32K14x web links:
> S32K Overview
> S32K144 Evaluation Board:
  > Getting Started
  > S32K144EVB Quick Start Guide
  > S32K144EVB-Q100 schematic
  > S32K1xx Fact Sheet
  > S32K1xx Data Sheet
  > S32K14x Reference Manual
  > S32K1xx Product Brief
> SW Tools:
  > FreeMASTER Run-Time Debugging Tool
  > S32 Design Studio IDE
The FreeMASTER JumpStart project description

Pins of the J2, J1 and J6 connectors are configured as outputs. By single click on each pin you can change their logical level to log0 or log1. User can connect e.g. LED diodes to these output pins.

Pins of the J3, J4 and J5 connectors are configured as inputs. Logical level (log0/log1) is visualised for all connector pins. User can connect e.g. push-button keyboard to these input pins.

Links to S32K14x docs:
- Fact Sheet
- Data Sheet
- Reference Manual
- Product Brief
- S32K144EVB schematic
- S32K144EVB Quick Start Guide

Tools:
- FreeMASTER
- S32 Design Studio IDE
- S32K144EVB OOBE source files
The FreeMASTER JumpStart oscilloscope feature examples

- Display main project panel „Project > View > Project Tree“.
- Display real-time oscilloscope graph examples such as „Potentiometer“ or „Touch Sense Electrodes“.

Analog values from potentiometer.

Responses from touch sense electrodes.
INTRODUCTION TO OPENSDA
Introduction to OpenSDA: 1 of 2

OpenSDA is an open-standard serial and debug adapter. It bridges serial and debug communications between a USB host and an embedded target processor. OpenSDA software includes a flash-resident USB mass-storage device (MSD) bootloader and a collection of OpenSDA Applications. S32K144 EVB comes with the MSD Flash Programmer OpenSDA Application preinstalled.

Follow these instructions to run the OpenSDA Bootloader and update or change the installed OpenSDA Application.

**Enter OpenSDA Bootloader Mode**

1. Unplug the USB cable if attached
2. Set J104 on position 1-2.
3. Press and hold the Reset button (SW5)
4. Plug in a USB cable (not included) between a USB host and the OpenSDA USB connector (labeled “SDA”)
5. Release the Reset button

A removable drive should now be visible in the host file system with a volume label of BOOTLOADER. You are now in OpenSDA Bootloader mode.

**IMPORTANT NOTE:** Follow the “Load an OpenSDA Application” instructions to update the MSD Flash Programmer on your S32K144 EVB to the latest version.

**Load an OpenSDA Application**

1. While in OpenSDA Bootloader mode, double-click SDA_INFO.HTML in the BOOTLOADER drive. A web browser will open the OpenSDA homepage containing the name and version of the installed Application. This information can also be read as text directly from SDA_INFO.HTML
2. Locate the OpenSDA Applications
3. Copy & paste or drag & drop the MSD Flash Programmer Application to the BOOTLOADER drive
4. Unplug the USB cable and plug it in again. The new OpenSDA Application should now be running and a S32K144 EVB drive should be visible in the host file system

You are now running the latest version of the MSD Flash Programmer. Use this same procedure to load other OpenSDA Applications.
Introduction to OpenSDA: 2 of 2

The MSD Flash Programmer is a composite USB application that provides a virtual serial port and an easy and convenient way to program applications into the KEA MCU. It emulates a FAT16 file system, appearing as a removable drive in the host file system with a volume label of EVB-S32K144. Raw binary and Motorola S-record files that are copied to the drive are programmed directly into the flash of the KEA and executed automatically. The virtual serial port enumerates as a standard serial port device that can be opened with standard serial terminal applications.

Using the MSD Flash Programmer

1. Locate the .srec file of your project, file is under the Debug folder of the S32DS project.
2. Copy & paste or drag & drop one of the .srec files to the EVB-S32K144 drive

The new application should now be running on the S32K144 EVB. Starting with v1.03 of the MSD Flash Programmer, you can program repeatedly without the need to unplug and reattach the USB cable before reprogramming.

Drag one of the .srec code for the S32K144 the S32K144 EVB board over USB to reprogram the preloaded code example to another example.

NOTE: Flash programming with the MSD Flash Programmer is currently only supported on Windows operating systems. However, the virtual serial port has been successfully tested on Windows, Linux and Mac operating systems.

Using the Virtual Serial Port

1. Determine the symbolic name assigned to the EVB-S32K144 virtual serial port. In Windows open Device Manager and look for the COM port named “PEMicro/Freescale – CDC Serial Port”.
2. Open the serial terminal emulation program of your choice. Examples for Windows include Tera Term, PuTTY, and HyperTerminal
3. Press and release the Reset button (SW0) at anytime to restart the example application. Resetting the embedded application will not affect the connection of the virtual serial port to the terminal program.
4. It is possible to debug and communicate with the serial port at the same time, no need to stop the debug.

NOTE: Refer to the OpenSDA User’s Guide for a description of a known Windows issue when disconnecting a virtual serial port while the COM port is in use.
INSTALLING S32DS
Download S32DS

Download S32DS from:

http://www.nxp.com/S32DS
CREATE A NEW PROJECT IN S32 DESIGN STUDIO
Create New Project: First Time – Select a Workspace

• Start program: Click on “S32 Design Studio for ARM v1.3” icon
• Select workspace:
  - Choose default (see below example) or specify new one
  - Suggestion: Uncheck the box “Use this as the default and do not ask again”
  - Click OK
Create New Project: Top Menu Selection

• File – New – Project
Create New Project: S32DS Project

- Project Name:
  - Example: FirstProject

- Project Type:
  - Select from inside executable or library folder

- Next
Create New Project: S32DS Project

- Select Debugger Support and Library Support
- Click Finish
OpenSDA Configuration

• To Debug your project with OpenSDA, it is necessary to select the OpenSDA in the Debug Configuration.

• Select your project, and click on debug configuration.
OpenSDA Configuration

- Select the Debug configuration under GDB PEMicro Interface Debugging
- Click on Debugger tab
OpenSDA Configuration

• Select OpenSDA as the interface, if your board is plugged should appear in the Port field.
• Click Apply and debug to finish.
DEBUG BASICS
Debug Basics: Starting the Debugger

- Debug configuration is only required once. Subsequent starting of debugger does not require those steps.

- Three options to start debugger:
  - If the “Debug Configuration” has not been closed, click on “Debug” button on bottom right
  - Select Run – Debug (or hit F11)

  Note: This method currently selects the desktop target (*project.elf*) and gives an error. Do not use until this is changed.

  - **Recommended Method**: Click on pull down arrow for bug icon and select …_debug.elf target
Debug Basics: Step, Run, Suspend, Resume

- Step Into (F5)
- Step Over (F6)
- Step Return (F7)
- Run
- Suspend
- Resume (F8)
Debug Basics: View & Alter Variables

- View variables in “Variables” tab.
- Click on a value to allow typing in a different value.
Debug Basics: View & Alter Registers

- View CPU registers in the “Registers” tab
- Click on a value to allow typing in a different value
- View peripheral registers in the EmbSys Registers tab
Debug Basics: View & Alter Memory

- Add Memory Monitor

- Select Base Address to Start at: 40000000

- View Memory
Debug Basics: Breakpoints

Add Breakpoint: Point and Click

- light blue dot represents debugger breakpoint
Debug Basics: Reset & Terminate Debug Session

- Reset program counter
- Terminate Ctl+F2()
CREATE A P&E DEBUG CONFIGURATION (OPTIONAL)
New P&E debug configuration

- Click in debug configurations
New P&E debug configuration

- Create a new P&E launch configuration

Click to create a new P&E launch

Click on the debugger tab.
New P&E debug configuration

- Select S32K144 device

- Click Apply and debug your application